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Device
Warnings, Cautions, and Contraindications

Warnings
A warning indicates the possibility of injury to user or the operator of this device

This manual serves as a reference.
Read and understand the entire manual before using the device.
Discontinue use if skin reddening or inflammation appears.
Do not smoke while wearing the BMC SleepCareTM.
Do not use USB data cable for communication to PC while the device is recording.
Only the USB data cable offered by BMC can be used for SleepCareTM communication to PC,
otherwise it may cause danger to the operator or the patient.
Do not use the SleepCareTM device in situation where alarms are required. The SleepCareTM
device has no audible alarms.

Cautions
A caution indicates the possibility of damage to the device.

This device is to be sold by or on the order of a physician.
Avoid exposure to sources of direct airflow such as fans during recording.
Avoid using this device in an MRI environment or in close proximity to a high EMI emission
source.
Do not attempt to take the main device apart. No user-serviceable parts are inside.
Do not immerse the main device in water.
If any unexplained changes are noticed in the performance of this device, if the device is dropped
or mishandled, if water is spilled into the enclosure, or if the enclosure is broken, discontinue use
and contact BMC.

Contraindications
Depending on the skin condition or general state of health, the patient may experience sensitivity
to the wrist belt or the self-adhesive finger sensor. Discontinue use if a reaction to the
skin-contact materials happens.
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Intended Use
The SleepCareTM device is indicated for the screening of sleep disordered breathing. It records
the following data: patient respiratory oral and nasal airflow, snoring, blood oxygen saturation,
pulse rate and CPAP pressure. The device uses these recordings to generate a report for
screening or for further clinical investigation.

System Contents
1 User manual
1 SleepCareTM main device
1 USB data cable
1 Pulse oximeter sensor
1 Oral and nasal airflow unit (optional)
1 Cannula （optional）
1 CD

Figure 1-1 System Contents

The belt on the main device is in accordance with the ISO 10993-1, ISO 10993-5, ISO10993-10.
The finger sheath and cannula are CE marking approved, indicating compliance to the Medical
Device Directive (93/42/EEC).
Several accessories are available for using the SleepCareTM. To ensure that the patient experiences
a safe and effective use, adopt only BMC accessories.
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Symbols
These symbols are used on the SleepCareTM devices.
Type B Applied part

Attention, Consult Accompanying Documents
IPX1

IPX1 –Drip-Proof, Vertical

SN

Serial Number of the product
Manufacturer

Authorised Reprisentative in the European Community

European CE Declaration of Conformity

SleepCareTM Display

Figure 1-2 SleepCareTM Display

SpO2% Display
Display the value in percent of oxygen saturation.
z

Pulse Rate Display
Display the pulse rate in beats per minute.
z

Note:
1. The sampling rate of the SpO2 signal is about 50Hz, and the update rate of the frame is 1Hz. So even there
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are some filtering methods to process the SpO2 data, it will not delay for a relative long time to the displaying data.
2. The waveform of the pulse is normalized so that the software can adjust the amplitude of the displayed
waveform. However, the SleepCareTM does not store the waveform data, just keeps waveform updating to give the
implication of the detector in working state.
Recording Time
Show the length of recording time
z

CPAP Pressure
Display the direct component of airflow pressure.
z

Pulse Waveform
The yellow line depicting the artery pulse feature
z

Snore Waveform
The green line indicating the occurrence of a snore
z

z
Respiratory Waveform
The red line reflecting user’s respiration fluctuation

Instructions for Use
Fitting
1. Remove the SleepCareTM main device, oral and nasal airflow unit, pulse oximeter sensor and
the two batteries from the package.
2. Open the battery door at the left side of the device. Insert two new AAA batteries following
the polarity markings indicated on the battery door. Carefully position the battery door and
gently get it into place.
3. Fit the oral and nasal pressure cannula so that the two small open tubes point towards
patient’s nostrils while the third open tube pointing towards his/her mouth.
4. Fit the loop round the patient’s ears and then back around the neck, avoiding pulling it over
the head.
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Figure 1-3 Illustration of Wearing the Cannula

5. Move the slide towards the user’s chin, until the cannula feels secure under the nose.
6. Fit the farther end of the cannula into the tubing end of the oral and nasal airflow unit and
insert its data cable into the Flow/COM (left) port at the main device bottom, where the
recorded data could be downloaded by a computer.
7. Put the oximeter data cable plug into the SpO2 (right) socket at the device bottom.
8. Insert the index finger into the pulse oximeter sensor. Take note that the finger must reach
the end of the sensor.

Figure 1-4 Illustration of Wearing the Pulse Oximeter Sensor

9. Wear the SleepCareTM main device around user’s wrist just like wearing a watch. Adjust it for
a comfortable position and fasten the belt to make it fixed.

To the oral and nasal airflow unit

Figure 1-5 Illustration of Wearing the Main Device
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Note: The SleepCareTM device is watch style, intended for screening sleep-disordered breathing for
adult patients only.

Recording

Figure 1-6

Main Device

Figure1-7 Setup

Figure 1-8 Date Setup

1. Start the device by pressing and holding OK button, the four icons, Record, Setup,
Archives, and Tools, are showing in the display screen.
2. Navigating the icons via Shift button and select the intended function by pressing OK
button.
3. Setup allows changing some of the recording parameters, see Figure 1-7. For example, user
7
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can choose whether or not to save the flow data, the snore data, and whether or not to need
an auto-save or auto-stop. Several different lengths of time are available in the auto-save
menu for user’s satisfaction. Thus, the patient can preset it when he/she is awake, needing no
further operation before falling asleep. This device also has an auto-stop function, with a set
of different periods of time after which the device may be triggered turn-off by sensor
removal. That is to say, it can stop recording when the sensors are dropped intentionally or
by accident after the set time. Users can also set an appropriate time for the Backlight using
the “Display(s)” setup. The “Date Setup” allows users to enter the date and time of
recording, see figure 1-8. While the cursor is at each settable item, press Shift to decrease the
value and OK to increase it. Press and hold Shift to move the cursor to its left position, and
when the cursor reaches the left side, it restarts from the right side of the other line. OK
button has a similar function but with its moving direction towards right.
4. Record. When this icon is selected, the device enters the recording page.
5. Archives. This icon offers information on the recorded data. The device allows 59 hours of
accumulated recording time of full data. But only the latest 8 pieces of data files can be seen
through the OLED interface. Enter Archives in the main menu and press OK, the on line
instant test scores are summarized to the user instantly with acceptable accuracy and much
convenience, see figure 1-9. This is just a concise report. Detail data can be reviewed by the
PolyLogicTM sleep analysis software on a computer.
6. Tools. This icon offers methods of data transfer. In addition to the traditional data
transferring with USB communication port, SleepCareTM gives users another choice of
transferring data by blue tooth, which is available depending on the customization. The data
entries can be viewed when entering the data transferring page, please refer to “PolyLogicTM
Sleep Analysis Software for SleepCareTM” in this manual for details. Press and hold both
“shift” and “OK” buttons to quit this data-entry page. “About” shows device information
such as the version, available memory, battery power and the current time, see figure 1-10.
Press any key to quit.

Figure 1-9 Online instant test scores

Figure 1-10 About

7. The device automatically turns off in one minute if no action is taken in this page.
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Note: While recording, the OLED colorful display will be off after a set time since the last keystroke and it can
be activated again by another hit on the key.
8. Follow the direction of the 4th step to enter the recording page, then press and hold OK
button to start recording. The timer in the up left corner begins to run. Keep the device on
and go to sleep.
9. Press and hold both Shift and OK buttons at the same time to quit record process.
10. Press and hold OK button to turn off the device.
Note: Please put the batteries out of the device when the SleepCareTM is not in use for a long time.

Disassembly
1. Lower the slide from under the patient’s chin and take off the cannula. Take off the pulse
oximeter sensor. Unplug the data cables from the SleepCareTM main device.
2. Put the cannula off the oral and nasal airflow unit.
3. Remove the batteries and discard according to local regulations.
4. Keep the SleepCareTM main device and the accessories appropriately under the instructions
of medical provider.

Important Steps for Use
It is of essential importance to have the OLED display screen checked to ensure an effective and
correct recording before sleeping.
The red line indicating respiratory waveform must be fluctuating with the breathing rhythm,
while the yellow line which stands for the pulse fluctuation should also vary thereupon.
Check the SpO2 and PR (Pulse Rate) to see whether the pulse oximeter sensor is in good
position for operation.

Conditions That May Affect The SleepCare Use
• Environmental
Fluctuating or flickering light may affect measurements.
Use of the SleepCareTM outside stated temperature and humidity specifications may affect measurements.
Contraindications, Warnings, and Cautions.

• Motion
Excessive or rapid movement may affect measurements.

• Sensor Position
Sensor position is critical for accurate SpO2 measurements.
All emitted sensor light must pass through the finger before reaching the detector. Do not allow positioning such
that some or all of the emitted light can by-pass the finger as this will result in inaccurate SpO2 values.
While on the finger, do not press the SleepCareTM against any surface and do not squeeze or hold the SleepCareTM.
The external spring provides the correct pressure on the finger; additional pressure may affect measurements.
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• Nail Polish
Fingernail polish may reduce light transmission which may affect SpO2 values.
In addition, the following factors may degrade performance:

• an arterial catheter • moisture in the SleepCareTM
• a blood pressure cuff • a finger outside the 0.3-1.0” size range
• an electrosurgical procedure • venous pulsations
• an infusion line • anemia or a low hemoglobin count
• cardiovascular dyes • the SleepCareTM not at heart level

Troubleshooting
Symptoms

Possible Cause

Possible Solution

OLED display blinking

Batteries are low.

Replace batteries immediately.

SleepCareTM

Batteries incorrectly inserted.

Check batteries.

Depleted batteries.

Replace batteries.

The red line keeps straight

The cannula is not properly

Adjust the cannula and make sure

without fluctuation.

positioned or is not connected to

it is connected firmly to the main

the main device, or is pinched.

device, or contact the medical

will not activate.

provider or BMC for a change.
The yellow line does not move.

The pulse oximeter sensor may

Adjust the pulse oximeter sensor.

not in the correct position.

Specifications
1. Oxygen Saturation Range
2. Pulse Rate Range
3. Oral and Nasal
Airflow Rate Range
4. Wavelengths
a) Red:
b) Infrared:
5. Accuracy
a) % SpO2 Accuracy
b) Rate Accuracy
6. Resolution
a) SpO2
b) Pulse Rate
7. Temperature
a) operating

0 to 100%
40-240 bpm
10/minute~40/minute

660 nanometers @ 3mw nominal
905 nanometers @ 3mw nominal
70 to 100% ±3%
the larger of ±3% and 1bpm
1%
1bpm
5℃～40℃
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8.

9.

10.
11.
12.
13.
14.
15.

b) storage/Transportation
-20℃～+55℃
Humidity
a) Operating
30% to 80% non-condensing
b) storage/ transportation
≤93% non-condensing
Atmosphere Pressure
a) Operating
860hPa~1060hPa
b) Storage
500hPa~1060hPa
Power Requirements
2 AAA Batteries of 1.5 VDC
Batteries Life
approximately 16 hours of continuous operation
Dimensions
62mm × 57mm× 21mm
Weight
70g (main device without batteries)
Max. recording period for one measurement
10hours
Classifications per IEC 60601-1

Type of Protection
Degree of Protection

Internally Powered (on battery power)
Type B-Applied Part

Degree of Protection Against Ingress of Water

IPX1

Mode of Operation

Continuous

Cleaning
Caution:
• Never use abrasive agents, alcohol, chlorine-containing substances, acetone, or other solvents
to clean the recorder.
• Do not immerse the recorder, the oral and nasal airflow unit, or the pulse oximeter sensor in
fluids, and ensure that no fluids penetrate into the products.
• Do not attempt to disinfect or sterilize the recorder, since this could cause unseen damage to
the inside of the unit.
• The cannula is nonreusable, dispose of it in accordance with local regulations.
1. Turn off the SleepCareTM.
2. Detach the oral and nasal airflow unit and the pressure cannula.
3. Detach the pulse oximeter sensor from the SleepCareTM main device.
4. Clean the following parts with a damp cloth and a mild liquid soap: oral and nasal airflow unit,
pulse oximeter housing and pulse oximeter cable.
5. Leave the cleaned parts to dry.

Disinfection
Between patient uses, the SleepCareTM should be surface disinfected in accordance with
established clinical practice.
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Disposal
Dispose of the device in accordance with local regulations.

EMC Requirements
Guidance and Manufacturer’s Declaration – Electromagnetic Emissions
This Device is intended for use in the electromagnetic environment specified below. The user of
the Device should assure that it is used in such an environment.
Emissions Test
Compliance Electromagnetic Environment - Guidance
RF Radiated Emissions
Group 1
This Device uses RF energy only for its internal
CISPR 11
Class B
function. Therefore, its RF radiated emissions are
very low and are not likely to cause any
interference in nearby electronic equipment.
RF Conducted Emissions
This Device is a battery operated device; therefore, these test
CISPR 11
requirements are not applicable
Harmonic Emissions
IEC 61000-3-2
Voltage
Fluctuations/Flicker
Emissions IEC 61000-3-3

Guidance and Manufacturer’s Declaration – Electromagnetic Immunity
This Device is intended for use in the electromagnetic environment specified below. The user of
the Device should assure that it is used in such an environment.
Immunity Test
IEC
Compliance Electromagnetic Environment 60601
Level
Guidance
Test
Level
Electrostatic Discharge
Floors should be wood, concrete or
±6 kV
±6 kV
(ESD)
Contact
Contact
ceramic tile. If floors are covered
IEC 61000-4-2
±8 kV Air ±8 kV Air
with synthetic material, the relative
humidity should be at least 30%.
Electrical Fast
This Device is a battery operated device and has no
Transient/Burst
patient-coupled cables nor I/O cables which are longer than 3
IEC 61000-4-4
meters in length; therefore, this test requirement is not applicable.
Surge
This Device is a battery operated device; therefore, these test
IEC 61000-4-5
requirements are not applicable.
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Voltage Dips, Short
Interruptions and Voltage
Variations on Power Supply
Input Lines
IEC 61000-4-11
Power Frequency (50/60
Hz) Magnetic Field
IEC 61000-4-8

3 A/m

3 A/m

Power frequency magnetic fields
should be at levels characteristic of a
typical location in a typical home or
hospital environment.

Guidance and Manufacturer’s Declaration – Electromagnetic Immunity
This Device is intended for use in the electromagnetic environment specified below. The user of
the Device should assure that it is used in such an environment.
Immunity
IEC
Compliance
Electromagnetic Environment - Guidance
Test
60601
Level
Test
Level
Portable and mobile RF communications equipment
should be used no closer to any part of the Device,
including cables, than the recommended separation
distance calculated from the equation applicable to the
frequency of the transmitter.
Recommended Separation Distance
Conducted
RF
IEC
61000-4-6
Radiated
RF
IEC
61000-4-3

3 Vrms
150 kHz
to 80
MHz
3 V/m
80 MHz
to 2.5
GHz

3V

80 MHz to 800 MHz
800 MHz to 2.5 GHz

3 V/m

where P is the maximum output power rating of the
transmitter in watts (W) according to the transmitter
manufacturer and d is the recommended separation
distance in meters (m).
Field strengths from fixed RF transmitters, as
determined by an electromagnetic site survey, a should
be less than the compliance level in each frequency
range. b
Interference may occur in the vicinity of equipment
marked with the following symbol:
13
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Note 1: At 80 MHz and 800 MHz, the higher frequency range applies.
Note 2: These guidelines may not apply in all situations. Electromagnetic propagation is
affected by absorption and reflection from structures, objects and people.
a
Field strength from fixed transmitters such as base stations for radio
(cellular/cordless) telephones and land mobile radios, amateur radio, AM and FM
radio broadcast and TV broadcast cannot be predicted theoretically with accuracy.
To assess the electromagnetic environment due to fixed RF transmitters, an
electromagnetic site survey should be considered. If the measured field strength
in the location in which the Device is used exceeds the applicable RF compliance
level above, the Device should be observed to verify normal operation. If abnormal
performance is observed, additional measures may be necessary, such as
re-orienting or relocating the Device.
b
Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3
V/m.

Recommended Separation Distance Between Portable and Mobile RF Communication
Equipment and the Device.
The Device is intended for use in the electromagnetic environment in which radiated RF
disturbances are controlled. The user of the Device can help prevent electromagnetic interference
by maintaining a minimum distance between portable and mobile RF communication equipment
(transmitters) and the Device as recommended below, according to the maximum output power
of the communications equipment.
Rated Maximum Output Power of
Separation Distance According to Frequency of
Transmitter (Watts)
Transmitter (meters)
80 MHz to 800
800 MHz to 2.5
150 kHz to 80
MHz
GHz
MHz
0.01
0.12
0.12
0.23
0.1
0.38
0.38
0.73
1
1.2
1.2
2.3
10
3.8
3.8
7.3
100
12
12
23
For transmitters rated at a maximum output power not listed above, the recommended
separation distance d in meters (m) can be estimated using the equation applicable to the
frequency of the transmitter, where P is the maximum output power of the transmitter
manufacturer.
Note 1: At 80 MHz and 800 MHz, the higher frequency range applies.
Note 2: These guidelines may not apply in all situations. Electromagnetic propagation is
affected by absorption and reflection from structures, objects and people.
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PolyLogicTM Sleep Analysis Software
for SleepCareTM
System requirements for running the software
1. hardware requirements: CPU≥P3 1.0G, memory≥512M, display resolution
≥1024×768， hard disk ≥80G
2. software platform: Windows XP/Windows 7/Vista

Setup
Setup of the Software
a) Run the “SETUP.EXE” of SleepCareTM in the installation CD and enter the setup page
b) Click ‘Next’ to make the software auto-install.
c) Click ‘Finish’ to quit when the installation is done. Double-click the new shortcut on desktop
to launch the software.

Setup of Driver
a) Double-click the “USBXpressInstaller.exe” in the USB driver folder.
b) Click “Next” in the prompt dialogue boxes, the driver will be installed automatically.
This may take several minutes to finish.
c) Click “Finish” when the setup is done.
d) The dialogue box prompting “found new hardware wizard” comes when the USB data
cable connected to a computer for the first time. Click “Next” and wait for the
installation finished. Click “Finish” when it is done.
Note: The “found new hardware wizard” comes only for the first time of a USB data cable connection. The
software can be directly used afterwards.

Data Reception
Data reception is to transmit the recorded data to computer. Software will analyze the data, and
then the operator can edit the results of the analysis to generate analysis reports. Data receiving
process is expressed as the following steps:
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Start Software
Firstly double-click shortcut of the software icon on the desktop, the system will enter the
SleepCareTM system main window.

Connection of SleepCareTM and Computer
In the power off status of the SleepCareTM, connect one end of the USB data cable to the
computer USB port, and the other end to the SleepCareTM Flow/COM socket and then turn on
the SleepCareTM. Enter Tools and choose Transfer Data (USB). Go on with operations of
“PolyLogicTM Sleep Analysis Software for SleepCareTM” on the computer to make the
connection.

Data Transmission
a) After recording, the data can be transmitted to a computer for further analysis. Besides,
SleepCareTM allows the analyzed data to be manually edited to remove the recording mistakes.
b) Run the software and choose the “File” from the main menu, select "New" to enter the
communication interface. Select USB port and click “Connect”.

Figure 2-1 Sleep Screener Online

c) If connection succeeds, the "Connect" button will be grayed. And other originally grayed
unavailable buttons will be available now. After online with the computer (see "connection of
SleepCareTM and computer"), SleepCareTM will automatically enter the communication status.
After the success of online, click "Replay" button in “Sleep Screener Online” dialog box and the
replay dialog box pops up (Figure 2-2).
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Figure 2-2 SleepCareTM Playback

d) The first content is data filename. The second is data type. Having the above two contents set
up, click "OK" and the pop-up dialog box of patient information (Figure 2-3) is then shown on
the display screen.

Figure 2-3 Patient Information Input

e) Recording start time is set by system at the beginning of the recording time which is confirmed
by the internal clock. If the SleepCareTM clock is not correct, modify it in the above login screen.
The recording end time defaults to 12 hours after the record start. In fact, in the process of data
transmission, the system can automatically identify the actual end time of record. SleepCareTM
will automatically stop after data transmission is finished. So need not to change the recording
end time in normal situation.
f) Enter patient information one by one.
g) When the login information input is finished, select “OK”. Then computer begin to receive
the recorded data. When data transfer is finished, the system returns to communications dialog
17
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box. At this time select "disconnect" or "return" in the dialog box, SleepCareTM will then
automatically exit from the communications status.
h) If another device is intended to connect to the computer, repeat the process of data reception.
If no data transmit is needed, click "back" button in the communication to return to the main
menu.

Data File Management
a) In the main window of SleepCareTM system, choose “Open” in “File” of menu bar, the system
will enter the sleep data management interface. The screen shows the saved data and its related
information in the hard disk (Figure 2-4). The desired data can be easily found out by different
orders in this page.
b) First of all, find out the route and catalog of the sleep data by using the Browse button. Then
all the files are listed, with the information such as file name, patient name, serial number,
recording date, record length, person on duty and data version etc. Click on the appropriate
classification column according to which the files are ranged to alter the files’ order.
c) In the lower right of the page are the function keys such as Open, Backup, Delete, and
Cancel. Click the file name to select the file, and then press the appropriate function key to
achieve data playback, data backup and data deletion.
d) Selecting the cancel button in the lower right of the page can return to the main window of the
SleepCareTM system.

Figure 2-4 Select Data File Dialog Box
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Data Playback
Under the sleep data management page, select the sleep data file, system will enter the data
playback interface.
If the data have not been analyzed yet, the prompt of auto analysis will be shown on the screen.
After opening the data file, system will enter the data playback window. There are the trend chart,
the waveform, the diagnosis result, the analysis report and other pages.

Open and Close the Data File
a) Multiple data files can be opened simultaneously in the main window of the SleepCareTM
system. For the method to open the data files please see the data file management part.
b) Opening a file may be failed if the file is being used.
c) Select the intended file name in the Window menu to open the file.
d) Clicking
in the toolbar or select “Close” in the “File” option in the menu may close the
current window of data file.

Display of Recorded Data and Analysis Result
The data recording, analysis result and statistical result are shown in 5 pages. The order is: the
trend, the raw data, the respiration event, the diagnosis result, and the report. The report includes
the concise report, the apnea analysis, the SpO2 analysis, and if the CPAP pressure is allowed, it is
also included.
The first chart displayed in the interface after the file is opened is the trend chart
other pages

,

,

,

and

can be shown via

clicking the corresponding tabs above.

Trend Chart
The trend chart demonstrates all the recorded parameters and analysis results during the entire
recording time. By demonstrating multiple parameters, one may observe the different physiology
parameters in the same period of time conveniently and may study the relationship between them
easily.
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Figure 2-5

Trend chart

The basic functions on the page are:
①Parameter browse
②Parameter deletion
③Event location
④Print
⑤Analysis
All the operations may complete through the menu choosing. Regarding the commonly used
operation, besides the provided menu operation, they may also be done by clicking on the toolbar
buttons.

①Parameter browse
The two buttons

in the toolbar may enlarge and reduce the time axis for glances over

the record parameter according to the different time resolution of the tendency change. Clicking
the two buttons

may make the cursor move forward and backward. The button

may open or close the display-assistant window, which is able to show each kind of parameter
value at the present time (where the cursor is). Clicks with a mouse throughout the trend chart
can drive the cursor to anywhere in it.
At the lower part of the trend chart lays a slide scale which can be dragged left and right to
change the cursor position.
20
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The main part of the window shows the data analysis result trend chart. The items in a top-down
order by default is, the saturation of blood oxygen trend chart, the apnea event length trend chart,
the respiratory rate trend chart, the number of snoring trend chart, and the heart rate trend chart.
The horizontal axis stands for the elapsing of time, with the time value marked above the
horizontal axis.
②Parameter deletion
Parameters that can be deleted in the trend chart include blood oxygen, heart rate and respiratory
rate.
in the toolbar may delete the invalid parameters.

Using the

If a certain part of the parameters during a period of time is to be deleted, left-click the mouse
and drag it to select the intended part in the chart, click the corresponding item from Trend of
the menu bar. It can also be done via the

、

、

、

icons in the toolbar. If only some

points in the chart are to be deleted, stay the cursor at the exact point and click the
、

、

、

button directly to erase them.

③Event location
Click on the chart to make the cursor stay anywhere it is wanted to be. Also, clicking on the “ ”
icon in the parameter page of assistant window can bring the viewer to the very moment when
this event took place. For example, clicking the
to the moment of the lowest value of oxygen saturation.

item is able to point the cursor

④Print
Use

to print or print preview the charts or reports. The printing function also goes

well in other pages.
⑤Analysis
If the data analysis work has not been done when file is opened or some parameters are not
correctly analyzed, a second analysis is necessary after an adjustment to the data. Select the
corresponding options to perform the respiratory analysis and/or snoring analysis.
The toolbar has provided three commonly used analysis shortcuts. The buttons “
the respiration event analysis process and the snoring analyzing process respectively.
Also, the analysis function works in other pages.

21
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Raw Data
This page can show all the recorded signals both in waveform and in numeric value. By different
walk speeds of paper, this system can display in the current time scope all the recorded features
in this page such as the recorded waveforms, the record parameters as well as the corresponding
analysis results and events.

Figure 2-6 Waveform Display

The following operations may be carried out in this page.
Print
Modify display setup
Modify paper speed
Modify time display
Event browse
Event edit
Mark function
① Print
Select

in the menu or

in the toolbar to print the analysis report.

② Modify display setup
Move the cursor to a certain waveform and right-click with mouse to access the pop-up menu,
select the correct item to change the gain and color of the waveform.
③ Modify paper speed
This function is aimed at conveniently observing the waveforms of different types.
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The tool
in the toolbar can zoom in and zoom out the time scale to
change the speed at which paper walks. The range is from 8s/page to 480 s/page.
④ Modify time display
This page provides many kinds of methods for the operator to locate any period of time
conveniently to observe the waveform and its parameters.
The two buttons

are used to slightly adjust the time back and forth as to when the

waveform shall be displayed, with five seconds as a pace.
The two buttons

are used for page turning with each page length depending on the

present speed of paper’s walking. For example, if the current displaying waveform walks at 1
minute/page, it shows the waveform of either previous or next one minute upon each clicking
on the icons.
is a time vernier, which

The bar

could be dragged back and forth or clicked on to show a waveform in varying time ranges.
Moving the mouse cursor to the left or right edges of the waveform where the cursor changes to
an arrow, can make the waveform walking at the speed of 2 seconds /page automatically.
The display contents can be located in accordance with the markings made by the editor or the
various events in the analysis. Refer to the event browse function and marking function in the
following parts for details.
⑤Event browse
a）Breathing event
All the breathing events are lined out with a series of colorful blocks in the graph, with the serial
number, the type and the length of each one annotated nearby. These breathing events are
categorized into HYP and OSA, which means hypopnea and obstructive sleep apnea, respectively.
And a previous event or next event can be easily located by clicking the

buttons.

b）Snore
The symbol “★” indicates a snore. In this operation, evaluations can be made to the sensitivity
of snoring threshold and it can be adjusted by modifying the threshold of snoring identification
and therefore changing the number of snores.
⑥ Event edit
The type and length of breathing events can be revised and every event can be inserted or
deleted in this page.
For changing the breathing event type or deleting any event, right-click on the event and select
the corresponding item to continue.
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For changing the length of a breathing event, firstly point the mouse cursor to the beginning or
the end of the block of event, when the mouse arrow changes into a draggable state. Then drag
the left or right edges to change the time of beginning and end.
For event insertion, left-click mouse and drag it to form rectangular block on the waveform,
when a menu pops up, demonstrating the length of this block. Select a corresponding event type
to generate such an event.
⑦Marking function
When the operator feels particularly interested in any recorded part and intends to relocate it on
his next opening of the file, he may use this marking function, attaching different marks to
different areas of interests.
Three symbols, A, B, and C are provided in this function. And the texts “+A”, “+B” or “+C” are
shown at the bottom of waveform.
in the toolbar is used to make a mark or

The

search for the previous or next mark. These markings can be kept while file-saving, thus can be
relocated quickly upon later reopening.

Respiration Event
This page has listed all respiration events and their correlations with the statistical data by form.
The respiration event list may sort according to different statistical items, with just clicking on the
corresponding statistical tags. And the list will be shown in the intended manner.
Clicking on the list or using the ↑↓ key on keyboard may choose any event in the respiration
event list. Click the corresponding button from the “Respiration Event” drop-down menu to
change the type of an event. The displaying order of the list of events is not changed at the
moment.
Above the respiration event list is the corresponding waveforms where all the respiration events
are characterized by blocks of different color. Right-click on the event block, select the
corresponding option to revise or delete an event. When the mouse arrow becomes draggable at
the beginning or end of an event block, drag it back and forth to shorten or lengthen the time of
the respiration event. Also, a respiration event can be inserted by dragging a rectangular block in
the waveform, The list of respiration events below will make a change to be ordered by serial
numbers accordingly.
Change the displaying page to a previous or next one, or, magnify and minify the time axis of
.

waveform by using the toolbar
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If the respiration event or the snore is to be analyzed for a second time, click

in the toolbar.

Figure 2-7 Respiration Event Edit
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Figure 2-8 Respiration Event

Analysis Form
All analysis results are produced into concise reports after statistical analysis. If the data
recording has contained the CPAP pressure, a CPAP pressure report is also included.

Figure 2-9 Analysis Report
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Diagnosis Result
The conditions and results of examination can be reached by selecting the corresponding items
in the drop-down menu. Both English and Chinese can be inputted in the suggestion field. All
the above reports can be printed out.

Figure 2-10 Diagnosis Result

Print Preview and Output
When the waveform is in need of printing, the waveform page should be activated to display.
Press

button or click on preview from the File menu under this page to preview the

present waveforms.
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Figure 2-11 Print and Preview of the Raw Data Waveform

In other pages, pressing

button or clicking on preview from the File menu may generate

a window for preview options. Select the intended report and press
button, the preview of report will be shown on the screen.

Figure 2-12 Print and Preview of the Report
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Similarly, selecting

button in the toolbar, or Print from File menu will show up the

window for preview options. The print work will be done after selecting the intended reports and

pressing the

button. Click

to change the printer

settings.

Exit Program
To back to Windows desktop just click File in the menu and click Exit or
corner.

at the top right

Service
Technical Support
For technical support and before returning any equipment, call BMC MEDICAL CO., LTD. at
86-10-51663880.

Limited Warranty
BMC MEDICAL CO., LTD. warrants that the SleepCareTM shall be free from defects of
workmanship and materials and will perform in accordance with the product specifications for a
period of one (1) year for main unit and three (3) months for all accessories from the date of sale
by BMC MEDICAL CO., LTD. to the dealer. During the warranty period, BMC MEDICAL
CO., LTD. will correct any defects in material or workmanship to conform to specifications, free
of charge. BMC MEDICAL CO., LTD. reserves the right to replace the SleepCareTM with a
comparable unit. Shipping costs are the responsibility of the purchaser. This warranty does not
cover damage caused by accident, misuse, abuse, alteration and other defects not related to
material or workmanship.
BMC MEDICAL CO., LTD. disclaims all liability for economic loss, loss of profits, overhead, or
consequential damages which may be claimed to arise from any sale or use of this product.

To exercise the rights under this warranty, contact the local, authorized dealers or:
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MANUFACTURER：
BMC MEDICAL CO., LTD.
5/F North No.2 Building, No.9 Shixing Street, Shijingshan District,
Beijing 100041, P.R.China
Tel: 86-10-51663880
Fax: 86-10-51663880 Ext. 810

EU AUTHORISED REPRESENTATIVE:
Shanghai International Trading Corp. GmbH (Hamburg)
Eiffestrasse 80, 20537 Hamburg，Germany
Tel: 0049-40-2513175
Fax: 0049-40-255726
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